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Preface

Audience and Purpose

This guide is intended for users charged with managing SnapServer appliances running
GuardianOS 7.2 or SnapScale nodes running RAINcloudOS 30 on their network using
SnapServer Manager (SSM). It provides server tasks, tips on maximizing SSM
functionality, and user scenarios. SnapServer Manager is usually installed on a network
computer in the same SAN as the SnapServers and SnapScale nodes it manages.

It is assumed that the administrator is familiar with the basic concepts and tasks of
multi-system network administration.

Product Documentation

The SnapServer Manager product documentation and additional literature are available
online, along with the latest release of the SnapServer Manager, GuardianOS, and
RAINcloudOS software.

Point your browser to:
http://docs.overlandstorage.com/SnapServer
or
http://docs.overlandstorage.com/SnapScale

Follow the appropriate link on that page to download the latest software file or document.
For additional assistance, search at http://support.overlandstorage.com.

Overland Technical Support

For help configuring and using your SnapServer Manager, search for help at:
http://support.overlandstorage.com/kb

You can email our technical support staff at techsupport@overlandstorage.com or get
additional technical support information on the Contact Us web page:

http://docs.overlandstorage.com/support
For a complete list of support times depending on the type of coverage, visit our website at:

http://docs.overlandstorage.com/care
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Conventions

This document exercises several alerts and typographical conventions.

Alerts

Convention

Description & Usage

IMPORTANT

An Important note is a type of note that provides information essential to
the completion of a task or that can impact the product and its function.

A CAUTION

A Caution contains information that the user needs to know to avoid
damaging or permanently deleting data or causing physical damage to
the hardware or system.

c WARNING

ADVERTISSEMENT

A Warning contains information concerning personal safety. Failure to
follow directions in the warning could result in bodily harm or death.

Un Canadien avertissement comme celui-ci contient des informations
relatives a la sécurité personnelle. Ignorer les instructions dans
I'avertissement peut entrainer des lésions corporelles ou la mort.

Typographical Conventions

Convention

Description & Usage

Button_name

Words in this special boldface font indicate command buttons found in
the Web Management Interface.

Ctrl-Alt-r

This type of format details the keys you press simultaneously. In this
example, hold down the Ctrl and Alt keys and press the r key.

NOTE

A Note indicates neutral or positive information that emphasizes or
supplements important points of the main text. A note supplies
information that may apply only in special cases, for example, memory
limitations or details that apply to specific program versions.

Menu Flow
Indicator (>)

Words with a greater than sign between them indicate the flow of actions
to accomplish a task. For example, Setup > Passwords > User
indicates that you should press the Setup button, then the Passwords
button, and finally the User button to accomplish a task.

Courier Italic

A variable for which you must substitute a value

Courier Bold

Commands you enter in a command-line interface (CLI)

Information contained in this guide has been reviewed for accuracy, but not for product
warranty because of the various environments, operating systems, or settings involved.
Information and specifications may change without notice.

Software Updates

The latest release of the GuardianOS software can be obtained from the Downloads and
Resources (NAS Solutions) page at the Overland Storage website:

http://docs.overlandstorage.com/SnapServer

10400352-002 12/2012
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The latest release of the RAINcloudOS software can be obtained from the Downloads and
Resources (SnapScale Solutions) page at the Overland Storage website:

http://docs.overlandstorage.com/SnapScale
Follow the appropriate instructions to download the latest software file.

For additional assistance, search at http://support.overlandstorage.com/.

Electrostatic Discharge Information

A discharge of static electricity can damage static-sensitive devices. Proper packaging and
grounding techniques are necessary precautions to prevent damage. To prevent
electrostatic damage, observe the following precautions:

e Transport products in static-safe containers such as conductive tubes, bags, or boxes.

¢ Keep electrostatic-sensitive parts in their containers until they arrive at static-free
stations.

e Cover the appliance with approved static-dissipating material.

e Use a wrist strap connected to the work surface and properly-grounded tools and
equipment.

¢ Keep the work area free of non-conductive materials such as foam packing materials.

e Make sure you are always properly grounded when touching a static-sensitive
component or assembly.

¢ Avoid touching pins, leads, or circuitry.
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Chapter 1 Overview

SnapServer Manager (SSM) is a Java-based application that runs on all major client
systems. SSM provides a single screen from which administrators can discover all
SnapServer servers (both GuardianOS and SnapOS versions), REO appliances, SnapSAN
arrays, SnapScale clusters, and Uninitialized nodes (that is, nodes that are not part of a
SnapScale cluster) on their network. Once found, an external application or browser can be
used for configuration and management of the systems. Additionally, SSM can monitor,
upgrade, and configure network and administrative settings on one or more systems
simultaneously.

This section is divided into sub-sections that provide the key processes and configuration
options needed to maximize your usage of SnapServer Manager:

¢ Tips and Requirements — Provides technical specifications and tips you need to know
before you begin using SSM.

e SnapServer Manager Main Window — Shows how to select the systems you want to
administer with SSM.

¢ Features List — Covers the multi- and single-system functions available in SSM.

¢ System Discovery — Explains how SSM discovers and maintains contact with systems.
This section is of particular interest to administrators who plan to install SSM on a
laptop.

¢ (Customizing the SSM Interface — Provides advanced procedures for creating Groups
and customizing the Details List.

e Usage Scenarios for GuardianOS SnapServers — Shows common scenarios providing
the fastest way to learn how to use SSM.

Tips and Requirements

Consider the following technical tips and requirements when deploying SnapServer
Manager on the network.

Normalize Admin Passwords for Groups (GuardianOS servers only)

Before you can configure a group of servers, the admin password for each server in the group
must be entered before you can perform any operations. If the members in the group have
different passwords for the admin account, you will have to remember and enter the
password for each member. Normalizing the password for the admin account for each group
member allows you to gain administrative access to all members in the group by entering
just a single password.
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SnapServer Manager Main Window

Right-Click vs. Control-Click

This document uses the Windows convention of right-clicking in describing keyboard access
to context-sensitive menus. Macintosh users should substitute control-click to achieve the
same result.

SnapServer Manager Main Window

The SnapServer Manager main window allows an administrator instant access to all the
supported systems on the network.

[('} SnapServer Manager - <All Servers »

[B][=1%

Fe Edit Administration Help
# Servers & Groups + EBerver Status IP Address Madel 08 YVersion Storage Usage
o mll FAll Serversd athos OK 10.25.3.80 (OHCP)[0] VirtualSnap | GOS 7.2.114 [ 16%used [~
¢ [ Jabherwacky beryl 0K 10.25.2.48 (DHCP)[0] VirtualSnap | GOS 7.2.114 [ 5% used
[ Snap1234567 binhstone Ok 10.25.12.165 (Static) [0] VirtualSnap | GOS7.2.114 [ 10%used
W Snap7h543zi blahfly oK 1025277 0] VirtualSnap| GOS 7.2.115 1 0% used
bmoalal Ok 10252238 (DHCP)[0] VirtualSnap | GOS 7.2.115 E_123% used
hbmoala2 Ok 10.25.2 244 (DHCP)[0] VirtualSnap | GOS 7.2.115 1718%used |=
hobbert Ok 10.25.2 246 (DHCP)[0] VirtualSnap | GOS 7.2.115 36% used
CCDragonfiyDR Online 10.25.12.25 (Static) [0] (SnapScale Cluster)| ROS 3.0.072 34% used
CCEMERALDGRM | Online 10.2512 159 (DHCFP)[0] | (SnapScale Cluster)| ROS 3.0.072 0% used
CCemeraldRED Online 10.25.12.46 (DHCP) [0] (SnapScale Cluster)| ROS 3.0.072 11% used f—
CCGalapanos-0 | OK 10.25.3.2 (DHCP) [0] VirtualNode | ROS 3.0.075
CCGalapagosh Online AN 2512 a0 INHCPY N iSnanSeale Cluster)| ROS 3.0.075
CCStorm520-1 Online i i Cluster)| ROS 3.0.075
[S5] CCStorm520-3 Detalls L|St 1alNode | ROS 3.0.075
CCStormB20-A Ok 10.25.2120 (DHCP)[0] RC1/ROS30075
CCStormBan-3 Ok 10.25.17.100 (DHCP)[0] RC1/ROS 30075
CCSunDragon Ok 10.251210 (DHCP)[0] RC1/ROS 30075
CCiiave210 Ok 10.25.3.139 (DHCP)[0] RC2| ROS 30075
CCWAVE41D Ok 10.25.16.150 (DHCP)[0] RC2| ROS30075
Ok 10.25.11.220 (Static) [0] RC2| ROS30075
[ eloringn B 10.25.2.190 (DHCP) [0] RC2|ROS 3.0.075
emerald-proto Online 10.25.3.148 (DHCP) [0] (SnapScale Cluster)| ROS 3.0.075
BVOIMP Online 10.25.3.147 (DHCP) [0] (SnapScale Cluster) ROS 3.0.075
fils Online 10.25.3.148 (DHCP) [0] (SnapScale Cluster) ROS 3.0.075
flyspeck 0K 10.25.11.50 (Static) [0] VirtualNode | ROS 3.0.075
Glaurung 10.25.11.230 (DHCP) [0] VirtualSnap | GOS 7.2.114
J¥-D05nap2300036 | Ok 192.168.51.61 [0] VirtualSnap | GOS 7.2.114
1 -0x2-Boogalon | Offling 10.2510.50 (Static) [0 el 2 hd
o operations are currently running or scheduled Status Bar T=@ Fx@ Online/Offline: 115/18)
SnapServer Manager

Overview of Main Window

The SnapServer Manager main screen is divided into three sections:

Groups List — Located on the left, it provides a collapsible list of supported systems
that can be sorted into groups for easier management.

Details List — Located on the right, it shows detailed information about each

supported system.

Status Bar — Located at the bottom of the screen, it provides specific information
about operations, transmissions, and availability.

Because it is a graphical interface, the main screen is able to convey large amounts of
information using specialized SSM icons for each system type and their current statuses.

10400352-002 12/2012
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SnapServer Manager Main Window

The Details List contains several columns of information. Use the hidden option list (right-
click the column names area) to make changes (see “Customizing the SSM Interface” on

page 1-9).

Server Column Icons

Server

Status

0s

Model

IP Address

OS Version
Humber
Up-Time {D:H:M}
Storage Usage
Discovery State
Configured
Expansion Units

Hew Column
Delete Column

Reset Columns

The Server column in the Details List of SnapServer Manager has visual cues to the status
and health of the systems on your network. The following color scheme applies to all icons
you see on the SnapServer Manager main window and any sub-windows that are displayed.

Server”  Node Cluster

Icon Icon Icon Description

- - - The item is online.

I | [E=sss] [Fa==9 One ormore status indicators indicate a warning-level condition.
- - - One or more status indicators indicate a fault-level condition.

I | [Eam] [F2=a9 Theitemis offline.

* Includes SnapServer servers, REO appliances, and SnapSAN arrays.

Status Column Icons

The Status column in the Details List uses the following icons to alert users to the different
statuses on systems managed by SSM. These icons follow the usual alert color-coding and
turn the appropriate color depending on the alert.

To check the status of a system, double-click the system name to open the Properties screen.

Icon

Description

Drive Status - Indicates whether a drive error has occurred. Double-click the system name to
check the specific problem.

All disks are OK.

A disk has failed.

=]

Disk status is not available (system may be offline).

10400352-002 12/2012
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Icon Description

Ethernet Status - Indicates whether an error has occurred with a NIC. Double-click the
system name to check the specific problem.

E All Ethernet ports are OK.

E An Ethernet port has no link.

E An Ethernet port has failed, or one Ethernet port in a bonded pair has no link.

E NIC status is not available (system may be offline).

Power Supply Status - Indicates whether the power to the system has encountered a
problem. Double-click the system name to check the specific problem.

@ All power supplies are OK.

=] A power supply is missing, has failed, or is not plugged in.
ot

Power supply status is not available (system may be offline).
[ ]

Fan Status - Indicates whether a fan on the system has encountered a problem. Double-click
the system name to check the specific problem.

EEH All fans are OK.

@ A fan is missing or has failed.

@ Fan status is not available (system may be offline).

System/CPU Temperature - Indicates whether the system or CPU temperature has
changed to possibly harmful levels. Double-click the system name to check the specific
problem.

m System or CPU temperature is OK.

@ System or CPU temperature is high.

m System or CPU temperature is critical.

E Temperature status is not available (system may be offline).

The Details List also displays a storage usage icon that shows what percentage of the space
on the system’s main volume is being used:

Icon Description

] Storage Usage - The blue bar Indicates how much of the storage space on the
system’s main volume has been used. The numerical usage percentage is shown to
the right. If the maximum is almost reached, the usage text is shown in red. Offline
systems display a question mark (?).

Communication Indicators

For all supported systems, the Status Bar displays two LED indicators that monitor the
transmission of discovery packets. Discovery packets are used to monitor the status of
systems that SSM is monitoring. The LED indicators are located next to the count of online
and offline systems at the bottom right of the screen. For more information about discovery
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packets, please see “System Discovery” on page 1-7.

Icon Description

Te el Tx stands for “Transmit” and lights whenever SSM sends out a request for
discovery information.

Rx stands for “Receive” and lights whenever SSM receives a discovery packet.

The mouseover tooltip displays the number of packets transmitted and
received, respectively.

Software Update Notification Banner

A banner is displayed across the top of the GUI whenever OS updates are available for
discovered systems.

r ]
@ =l
File Edit Administration Help

Software updates are available for one or more servers. Tell me more - Remind me later - Hide this message

W Servers & Groups 7 Server Status IP Address Madel 05 Wersion Storage Usage
o Ml =21l Servers= Alkan Ok 5.3.31 (DHCF) WirtualSnap | GO 7.2.114 L1 use ot
o [ Jabberwacky BACKUPDXICE 5.3.20 (DHCP) DX2|GOS7.2114 L1 use:

eyl QK 5.3.82 (DHCP) Dx1|Gos7.2111 L1 use

rn-real-kat Online 5.12.113 (DHCF) (SnapScale Cluster) |ROS 3 briansled!l 1 use

rmyalal (]38 5.2.180 (DHCP) VirtualSnap | GOS8 7.2.0-briansled11 gﬁ 6% used

The Software Update Notification feature is enabled by default, but can be disabled from Edit
> Options.

The Tell me more link in the banner opens the Software Updates dialog, listing the systems
for which an update is available, the version of OS each system is currently running, and the
updated version available for each system.

Tip: You can choose to hide the banner by clicking the “"Remind me later” or "“Hide this
message” link on the banner. When “Remind me later” is clicked, the system displays the
banner after the next check for updates; when “Hide this message” is clicked, the system
hides the banner for the specific update until a later version is released.

Features List

SnapServer Manager can be used to discover SnapServer servers, REO appliances,
SnapSAN arrays, Uninitialized nodes, and SnapScale clusters. However, status monitoring
is only available for GuardianOS servers and Uninitialized nodes, while advanced multi-
and single-system administration functions are only available for GuardianOS servers.

Features Common to All Systems Supported by SSM
Except where noted, the following single-system features are available for all systems
supported by SSM.

Discovering Systems on the Network

SnapServer Manager automatically discovers all supported systems on the same network
segment and displays them in the main SSM window. Additionally, SSM discovers systems
outside the local network if they have been added to the Remote Servers list. For more
information, see “System Discovery” on page 1-7.
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Launching External Administration

The Web Management Interface located on the systems from Overland is a browser-based
application that allows you to perform a wide range of administrative tasks on a system-by-
system basis. To launch this tool, right-click the system name or go to the Administration
menu and select Launch Web Administration.

GuardianOS$- and RAINcloudOS-Only Features

The following functions are available only for GuardianOS servers. For information on how
to perform the multisystem operations summarized below, see “Usage Scenarios for
GuardianOS Servers” on page 1-12.

Registering One or More GuardianOS SnapServers

To register multiple GuardianOS SnapServers, select the servers in the SSM screen, and
then select Administration > Register Servers. A separate browser window opens to a product
registration form in which some of your product information may already be entered.

Simultaneous Application of Settings to Groups

SnapServer Manager allows administrators to organize servers into functional groups and to
apply configuration modifications simultaneously to all GuardianOS SnapServers within a
group. For example, administrators can configure domain and other network settings for any
number of SnapServers in one operation and be confident the settings are consistently
applied across servers.

Comparing Settings Across GuardianOS SnapServers

SnapServer Manager can compare settings across any number of GuardianOS SnapServers
and identify when settings differ among servers. For example, comparing protocol access
configuration for a group of servers may reveal that settings are consistent for Windows,
NFS, and AFP but that differences exist among servers in HITP/HTTPS and FTP/FTPS
settings.

Assigning IP Addresses to SnapServers on a Network Without a DHCP Server

By default, SnapServers and Uninitialized nodes are preconfigured to use DHCP to acquire
an IP address at startup. If a SnapServer or Uninitialized node cannot find a DHCP server
on the network, you may not be able to access the system. SSM discovers all SnapServers,
Uninitialized nodes, and SnapScale clusters on its local subnet using a proprietary multicast
communication mechanism.

To set a static IP address for a specific SnapServer or Uninitialized node, right-click the
system name in the Details List and select Set IP Address.

Copying Settings from One System to One or More Different Systems

SnapServer Manager can copy selected settings (such as TCP/IP, SNMP, SMB access, etc.)
from any SnapServer to one or more different SnapServers. See Chapter 3, “Current
Settings for Servers”.

Scheduling Operations to Run During Off-peak Hours

Operations can be scheduled to run on multiple SnapServers during off-peak hours.
Chapter 3, “Apply Schedule (Start Later)”.
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Automatic Email Notification of Completed Operations

SnapServer Manager can automatically create and send an operations report (CSV format)
upon the completion of any operation on a SnapServer. See Chapter 3, “Operations Report”.

Monitoring System Status

The color coding of system and group names alerts administrators to warning and fault
conditions on a system. To view detailed status information, double-click anywhere in the
row in the Details List. See “Server Column Icons” on page 1-3.

Software Update Notification

SnapServer Manager is configured to check daily for available updates for both GuardianOS
and RAINcloudOS, and to display an alert at the top of the Details List when updates are
available.

To force SSM to check for available updates immediately, click Administration > Check for
Server Software Updates. SSM connects to the remote software update server, searches for
applicable updates for all of the discovered systems, and displays them in the Software
Updates dialog box.

System Discovery

At startup and once per minute afterward, SnapServer Manager broadcasts a discovery
request packet to its local subnet. Supported systems on the same network segment that
receive discovery requests respond with a discovery packet containing information. All other
discovery activity is performed using both direct communication (unicast) and a proprietary
multicast communication mechanism that does not impact other systems on the network.

When SSM sends or receives discovery packets, status LEDs at the right on the Status Bar
flash according to which activity is taking place. The LED labeled “Tx” flashes whenever SSM
sends out a discovery request. The LED labeled “Rx” flashes whenever SSM receives a
system discovery information packet.

You can add other supported systems that reside outside the local network segment by
entering their IP addresses in the Remote Server List (Edit > Remote Servers). This includes
SnapServers, Uninitialized nodes, and SnapScale clusters.

Tip: If SSM has not been able to communicate with a discovered system (for example, the
system is offline or has just been started), that system'’s IP address appears in blue and the
Properties screen for that system shows Not Validated next to the IP address. Once SSM has
successfully communicated with the system, the text color of the IP address changes to
black, and Validated appears on the Properties screen.

Local Discovery

A local system is one that resides on the same network segment as the machine on which
SnapServer Manager is installed. Overland systems regularly send multicast discovery
information to their local network segment, other systems broadcast their presence once on
startup, and all systems respond to discovery request broadcasts from SnapServer Manager.
SnapServer Manager passively listens for multicast or broadcast discovery information from
supported systems and broadcasts a discovery request packet on the local network segment
in three cases: (1) at startup; (2) once per minute; and (3) when the administrator manually
refreshes the information by selecting Edit > Refresh All.
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Remote Discovery

A remote system is one that resides on a network segment different than the one on which
SSM resides. SSM cannot hear discovery information broadcasts from remote systems until
the administrator configures them on the Remote Servers list (see “Configuring Remote
System Discovery Example” on page 1-8).

SSM regularly queries GuardianOS and RAINcloudOS systems on the Remote Servers list
for discovery information. When discovered, remote systems return information about
themselves, and remote systems also return information about any other GuardianOS and
RAINcloudOS systems on the same network. As a result, only one GuardianOS and
RAINcloudOS system needs to be added to the Remote Servers list per remote network to
discover all remote GuardianOS and RAINcloudOS systems on that network.

However, for non-GuardianOS/non-RAINcloudOS systems, each system must be added
individually to the Remote Servers list. Remote systems discovered in this manner display
the letter R in the Discovery State column of the Details List of the SSM screen, along with
the name of the discovering remote system, if applicable.

Tip: Forinstructions on displaying the Discover State column in the SSM screen, see “Details List.”

Configuring Remote System Discovery Example
For example, assume a remote network segment contains six systems:

¢ REO 4600 running the latest REO 4600 GUI (non-GuardianOS)
*  SnapServer DX2 running GuardianOS 7.2

¢ SnapSAN S2000 running SnapSAN 4.3 GUI (non-GuardianOS)
*  SnapServer 410 running GuardianOS 5.2

e SnapServer N2000 running GuardianOS 6.5

¢ SnapScale Cluster running RAINcloudOS 3.0

To enable SnapServer Manager to discover all these remote systems, the IP address of just
one GuardianOS server or RAINcloudOS node/cluster needs to be entered in the Remote
Servers List to discover all other GuardianOS- and RAINcloudOS-based systems on the
remote network segment. The non-GuardianOS/non-RAINcloudOS systems must be
manually added. Using a GuardianOS server or RAINcloudOS node/cluster as a remote
discovery system makes the administrator’s configuration task easier and reduces the
network traffic required to refresh system status.

Tip: For full interoperability, Overland recommends that all GuardianOS/RAINcloudOS systems
on the network run the same version of the system software. If you have systems running
different versions of the soffware on your network, use a system running the most current
version as the remote discovery server/node/cluster.

Laptop SSM Installation and Remote System Discovery

Unexpected results may occur in instances where SnapServer Manager is installed on a
laptop that is moved from one network segment to another. In this situation, the systems
that were previously in SSM’s local segment are now in a remote segment, and since no
remote system has been designated in that segment, SSM can no longer hear their discovery
information broadcasts. Thus, when SSM is started up in the new location, these systems
will display as offline.
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To Ensure All Systems Display Correctly in the SSM Screen

SnapServer Manager offers three methods to ensure all systems display correctly in the SSM
screen. The first option is the preferred method (available only if all systems are
GuardianOS servers or RAINcloudOS nodes/clusters) because this method results in less
network traffic than the other options; but any combination of methods can be used to suit
your environment.

Procedure Result

Add one GuardianOS (v. 2.6 or higher) server or SSM sends out only a single DRP
RAINcloudOS node/cluster from every network segment for each system on the Remote
(including the current local segment) to the Remote Servers Servers List.

List.

This option is applicable only if all servers/nodes/clusters
on the remote network are GuardianOS servers or
RAINcloudOS nodes/clusters.

For other systems, manually add each system to the SSM sends out a single DRP for
Remote Servers List. each system on the Remote
Servers List.

From SSM, select Edit > Options. Select the Auto-scan SSM sends out one DRP for each
servers not on Remote Server list option, and click OK.  previously discovered system,

This option instructs SSM to directly (and regularly) send resu]ting in increased network
DRPs to all previously discovered systems that are neither: traffic.

(1) specified on the Remote Servers list, nor (2) resident on

the same network segment as a system specified on the

Remote Servers list.

Customizing the SSM Interface

At startup, the SnapServer Manager displays all Overland systems discovered on the local
subnet as well as any remote supported systems manually configured by the administrator.
The default group <All Servers> contains all the discovered systems. Additional groups can be
created for easier administration.
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(("F SnapServer Manager - <All Servers > Q@
LEE Edit Administration Help
W Servers & Groups 7 Server Status IP Address Model 08 Yersion Storage Usage
o All Serve athos 0K 10.25.2.115 (DHCP) 4400 | GOS E.0.043 8% used o
o 03 Jabherwacky beryl 0K 10.25.2.18 (DHCF) D¥1|G0OS7.0.108 ?
E Snap1234567 binhstone COffline 182.168.193.191 217 ?
O Snap7654321 laffly offline 92166.193.147 77 7
maalal QK 0.25.2.78 (DHCP) WinualSnap | GOS 7.0.125-kdh 40% used =
moala2 OK 0.25.2.87 (DHCF) VinualSnap [ GOS8 7.1.0-briansled11 23% used
obhert QK .25.2.134 (DHCF) 4400|GOS 50133 EHT% used
CCDragonfyDR | Offline .193.199
% CCEMERALDGRM| Offling 138
CCemeraldRED | Offline 144
CCGalapagos-Q | Offline 1
co Offline 192168.193.205 77 ?
CCStorm520-1 Offline 192168.193.118 77 ?
CC5torm520-3 Offline 192168.193.222 77 ?
CCStormB20-A Offline 192168.193.227 77 ?
CCS5tormB50-3 Offline 192168.193.175 77 ?
CCSunDragont COffline 92168.192.208 217 ?
II: CCBunDragon2 | Ofline 92.168.192.117 77 ?
0 Coviawe210 QOfiling §2168.192.142 77 ?
COWAVESTD B 0.25.2.152 (DHCPY 410|GOE 52067 6% used
chunka QK 0.25.217 (DHCP) 210|GOE 52048 a7% used
daedalus QK 0.25.10.22 (Static) 4500 |GOS48.0133 69% used
dr-edr Ofiling §2168.192.178 77 ?
elgringa Offling §92.168.192.180 77 ?
emerald-proto COffline 182.168.193.140 217 ?
Erebar B 10.25.2.58 (DHCP) DH2[GOS 71.0- 11 [_10% used
evomp = EH 10.25.2.107 (DHCF) 18000 | GOS B.0.043 26% used
fils 9 = 10.254.2123 (DHCP) 18000 | G005 4.2.056 5P1 % 75% used
fyspeck Ok 10.25.2144 (DHCP) MN2000 | GOS 645023 0% used
Glaurung COffline 10.25.2.130 217 ?
[ JeremyGOET Offline 148
[T JH-M T Offline 146
[ JH-M2 Offline 105
[ JH-M3 Offline 234
[T JH410A Offline 166 A
Mo operations are currently running or scheduled. Tx@ Ree@ OnlinefOfine: THE6
SnapServer Manager

The Status Bar at the bottom shows the status of any running or scheduled operations.
Operations are defined as administrative tasks (for example, changing Windows/SMB
settings or configuring email notification) that are run concurrently.

Groups

SnapServer Manager allows administrators to organize systems into groups for ease of
administration. Different groupings can be created, saved, and shared with other
administrators. Clicking a group name displays only the group’s members in the Details list.
Clicking the button to the left of the group name shows all the systems under the name.

Group Color Coding

The folder color of a group reflects the highest level of alert for any of the systems in the
group.

Tip: Only GuardianOS servers or RAINcloudOS nodes/clusters display the warning and failure
color codes. A group with only non-GuardianOS/RAINcloudOS systems will be color-coded

grey.

The following shows a system group (groupl) that contains multiple systems. The group
folder is yellow because one or more GuardianOS servers or RAINcloudOS nodes/clusters
contain a warning-level condition associated with them. The <All Servers> folder above
groupl is red, indicating a failure-level condition on at least one GuardianOS server or
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RAINcloudOS node/cluster in that group. A grey folder next to group3 indicates none of the
systems in the group show warning or failure indicators or that it doesn’t contain a
GuardianOS server or RAINcloudOS node/cluster.

ano SnapServer Manager - <All Servers>
# Servers & Groups Server | status | IP Address | Madel 05 Version | Storage Usage
» o [ CCStorm520-3 L] 192.168.193.195 (DH... 520 GOS 6.5.0-buildcrusher [ 0% used
» [ groupl I Glaurung L] 192.168.193.114 (DH... N2000 GOS 6.5.0.buildcrusher-... [ 0% used
» I groups [ evomp 56 B 192.168.192.171 (DH... 18000 GOS 6.0.043 1 26% used
[ COWAVE410 j2:5) 192.168.192.132 (DH... 410 GOS5.2.067 96% used
[ elgringo j2:5) 192.168.192.180 (DH... 14000 GOS5.1.046 B132% used
T fils = 192.168.192.240 (DH... 18000 GOS5.2.056 SP1 B 55% used
[ lambtron = 192.168.192.165 (Stati... 14000 GOS5.1.046 B 76% used
[ SNAP722394 j2:5) 192.168.192.108 (DH... 550 GOS5.2.067 127% used
[ snap723110 =] 192.168.192.122 (DH... 520 GOS5.2.053 1 50% used
[ tiberius 192.168.193.135 (DH... 7 GOS6.5.026 [ 0% used
[ vmstore3 192.168.192.125 (DH... 18000 GOS 6.0.043 B 50% used
[ athos oK 192.168.192.143 (DH... 4400 GOS6.0.043 [ 8% used
[ birthstone OK 192.168.193.191 (DH... DX1 GOS7.0.106 [ 0% used
- [ blahfly oK 192.168.193.147 (DH... N2000 GOS6.5.026 0% used
[ bmgalal oK 192.168.192.146 (DH... VirtualSnap GOS 7.0.1.briansled11-... ] 17% used
[ bmgala2 0K 192.168.192.215 (DH... VirtualSnap GOS 7.0.1-briansled1l [ 17% used
[ bobbert OK 192.168.192.140 (DH... 4400 GOS5.0.133 B136% used
[ CCDragonflyDR oK 192.168.193.110 (DH... N2000 GOS6.5.023 1 34% used
[ CCEMERALDGRN OK 192.168.193.183 (DH... DX1 GOS7.0.124 3% used
[ CCEMERALDMFG oK 192.168.192.205 (DH... DX1 GOS7.0.124 [ 0% used
[ CCEmeraldRed OK 192.168.193.182 (DH... DX1 GOS7.0.124 [ 1% used
[ CCGalapagos-Q 0K 192.168.193.91 (DHCP... VirtualSnap GOS 7.0.089 B 73% used
[T CCGalapagos6 oK 192.168.193.205 (DH... VirtualSnap GOS 7.0.085 0% used
[ CCGalapagosDRI 0K 192.168.193.221 (DH... VirtualSnap GOS 7.0.100 = 100% used
[ CCStorm650-3 OK 192.168.193.175 (DH... 650 GOS5.2.067 [ 0% used
[ CCwavez 10 oK 192.168.192.142 (DH... 210 GOS6.5.023 [ 0% used
[ daedalus OK 192.168.192.32 (Static... 4500 GOS5.0.133 ] 73% used
[ dr-edr 0K 192.168.193.88 (DHCP... VirtualSnap GOS 7.0.1-breessled1l [_] 5% used E
I DynR aid Test. fal'a 197 1AR 197 102 (DH VirtualSnan  GOS 701 7 b4
No operations are currently running or scheduled. O, Tx@ Rx@ Online/Offline: 111/2

SnapServer Manager’ y

Creating, Populating, and Maintaining Groups

Use either the context menu (right-click a group name) or the Edit options (activated by
selecting a group name first) to make changes. The active options change based on which
item in the list is clicked.

Administer Servers...

Launch Weh Administration...
Set IP Address...

Wake Up Servers...
Properties...

Hew Group...
Rename Group...
Remove Offline Servers

Copy
Paste
Delete
Select All

Refresh All F&

In creating groups, you can perform the following operations:

Task Procedure

To create a new group on Right-click the Servers & Groups top level and select New

the root Group. Enter a unique name in the dialog box that opens and
click OK. The new group is added alphabetically to the root of
the Groups List tree.

To create a new group Right-click a group name and select New Group. Enter a
inside another group unigue name in the dialog box that opens and click OK. The
new group is nested inside the original group.

10400352-002 12/2012 ©2010-12 Overland Storage, Inc. <41-1



SnapServer Manager 7.2-3.0 Users Guide Customizing the SSM Interface

Task Procedure

To copy multiple systems Select one or more system names from the Details list, and do
from the Details Listto a one of the following:

group * Right-click one of the highlighted rows and select Copy.
Select a group, then right-click and select Paste.

* Click-and-drag one of the highlighted rows to the group.

To copy the contents of Right-click a group and select Copy. Then, right-click the target
one group into another group and select Paste.

group

To rename a group Right-click a group and then select Rename Group. Enter a
unigue name in the dialog box that opens, and click OK.

To delete a group Right-click a group and then select Delete. In the confirmation

dialog box that opens, click Yes.

Saving and Distributing Groups

Administrators who manage systems from different machines may want to have the same
group structures available from each SSM installation. Groups can be saved to an XML file
by highlighting the group and selecting File > Save Groups As. By default, this file is saved to
the home directory for your system.

For example, on a Windows machine, the location of the XML file in the default home
directory would be similar to the following:

C:\Documents and Settings\username\ssm groups.xml

To share groups, copy the XML files to an appropriate directory on any other machines used
to manage systems. Alternatively, you can select File > Open Groups and navigate to the
desired file.

Remove Offline Systems

Select Edit > Remove Offline Servers to remove offline systems from groups. An Include all
subgroups check box on the Confirmation dialog allows you to remove offline systems from
the subgroups of the selected group also. The subgroup removal option is checked by default
and is disabled (grayed) if the selected group has no subgroups.

Details List

The data displayed in the Details List can be customized to accommodate different
administrative interests.

Column Definitions

The Details List is divided into several different columns. Use the hidden menu (right-click
the column heading area) to add or delete columns. The following table defines the properties
shown in these columns:

Column Description

Server Lists the names of all discovered systems (servers,
appliances, arrays, nodes, and clusters).
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Column

Description

Status

* OK - All systems are functioning correctly.

¢ Offline - The system is offline.

* Alert Icon - Displays any warning ( ) or fault (red)
conditions for the selected GuardianOS server or
RAINcloudOS node/cluster. See the “Status Column Icons”
table on page 1-3 for a list and description of the different
icons.

IP Address

Displays the IP address and type (DHCP or Static) for the
system.

Model

Displays the type of system hardware (such as DX2 or
N2000)

OS Version

Displays the OS type (GOS, REO, SAN, or ROS) and version
number.

Storage Usage

Shows a percentage bar and the numerical percentage of the
amount of storage space used.

*

0Ss

Displays the operating system name of the system.

Number”

Displays the unique server number of the selected system.

Up Time (D:H:M)*

Displays how long a system has been up and running, in
days, hours, and minutes.

Discovery State”

Displays the date and time the listed system’s DRP was
received by SSM.

Configu red”

Displays whether or not the system has gone through the
initial configuration process. Displays yes, no, and partial.

Expansion Systems*

Displays the number and type of expansion units attached to
a system.

* These columns not shown in the default display. Must be added manually using the right-click menu.

Customizing the Details List

Use the following procedures to customize the information displayed in the Details List:

10400352-002 12/2012

Task

Description

To sort the Details List
according to a column

Click a column header. The Details List sorts according to the
contents of the column in ascending order. To sort in
descending order, click the column header again.

To resize a column header

Hover the cursor over the right border of the column header
you want to resize, and then click and drag the border to the
desired width.

To normalize the size and
contents of all column
headers

Right-click any column header and click Reset Columns. The
original factory set columns, properties, and order are
restored.

To load a different property
into a column

Right-click a column and select a different property.

To create a new column

Right-click a column, and select New Column. The clicked
column is duplicated. Right-click the new column, and select
a different property (see “Column Definitions”).

To reorder columns

To reorder columns, simply configure the properties into the
existing columns in the order you want.
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Task Description

To delete a column Right-click a column header and select Delete Column.

Usage Scenarios for GuardianOS SnapServers

This section provides scenarios of the major types of operations you can perform on multiple
GuardianOS servers. Operations can be run immediately or be scheduled to run at a later
time. SSM can also automatically deliver reports on completed operations by email. Review
these scenarios to quickly learn the steps required to perform each of these operations:

¢ Viewing GuardianOS SnapServer Settings/Generating a Report

¢ Configuring Multiple GuardianOS SnapServers/Setting Up Email Notification

¢ Copying Settings Among GuardianOS SnapServers

¢ Scheduling an OS Update for Multiple GuardianOS SnapServers

Tip: If servers within a group have different passwords, you will have to remember and enfer

each password before you can administer the group. For ease of administration, configure
servers within a group with the same password.

Viewing GuardianOS SnapServer Settings/Generating a Report

A common problem for administrators is maintaining network and other settings across
large groups of servers. This scenario shows how to view and compare settings across a
group of servers in a single operation, and then generate a report in CSV format.
1. Select a group of servers.
In the SSM screen, select a group of servers and click Administer Servers. After you
enter the passwords for the servers, the Administer Servers dialog box opens.
Tip: Configure the servers within a group with the same password.

2. Select one or more tasks.
Administrative tasks are listed in the left-hand pane. Select each setting you want to
view, and then click View/Copy. The Current Settings for Servers dialog box opens.

3. Run the operation.

Click Start. The interface provides feedback on the progress of the operation. Color
coding indicates configurations whose settings are identical across servers and those
whose settings differ.

4. Generate an Operations Report (optional).
Once SSM retrieves server settings, click Report to save the settings to a CSV file.

Configuring Multiple GuardianOS SnapServers/Setting Up Email Notification

Configuring servers one-by-one is a tedious and error-prone process. This scenario shows

how to simultaneously configure multiple SnapServers in a single operation, eliminating

unnecessary administrative overhead and assuring consistency of settings across servers.
1. Select a server group.

In the SSM screen, right-click a server group and select Administer Servers. After you
enter the passwords for the servers, the Administer Servers dialog box opens.
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2

Edit settings for one or more tasks.

Administrative tasks are listed in the left-hand pane. Check any task to edit its
settings. For example, to edit the administrative password, check Admin Password. A
check mark appears before the task and its fields become editable, allowing you to
modify settings. Select and edit any other tasks, then click Apply. The Apply to Servers
dialog box opens.

Run the operation.
Click Start Now. The interface provides feedback on the progress of the operation.

Set up automatic delivery of operations reports (optional).

Once SSM applies server settings, click Report to open the Operation Report dialog box.
Select the Send e-mail report when operations finish option, enter the SMTP Server IP
address and the email address of at least one recipient, and then click OK.

Copying Settings Among GuardianOS SnapServers

SnapServer Manager allows administrators to apply configuration settings from one server
to a group of other servers in a single operation. This scenario shows how to copy specific
settings from one (source) server and apply those settings to a (target) group of other servers.

1.

3.

Select a server group.

In the SSM screen, right-click a server group and select Administer Servers. Make sure
the source server is included in the group. After you enter the passwords for the
servers, the Administer Servers dialog box opens.

Copy specified settings to the Administer Servers window.

In the settings pane to the left, select each setting you want to copy, and then click
View/Copy. In the Current Settings for Servers window, click Start. Once the settings
are retrieved, double-click the source server row, and then click OK at the confirmation
screen. To close the Current Settings for Servers window, click Close.

Apply the settings to the entire group.

In the Administer Servers window, click Apply. In the Apply to Server window, click
Start Now. The interface provides feedback on the progress of the operation.

Scheduling an OS Update for Multiple GuardianOS SnapServers

Updating the SnapServer operating system without interrupting client access is difficult to
achieve during normal working hours. This scenario shows how to update all GuardianOS
SnapServers on your network in a single operation scheduled during off-peak hours.

1.

10400352-002 12/2012

Select a server group.

In the SSM screen, right-click a server group and select Administer Servers. After you
enter the passwords for the servers, the Administer Servers dialog box opens.

Set up the OS Update task.

Select OS Update and if necessary, use the link to download the update file from the
SnapServer website to a location accessible to SSM over the network. Click the Browse
button to navigate to and select the update file. Click Apply to open the Apply to
Servers dialog box.

Schedule the operation to run at a later time.

In the Apply to Servers dialog box, click Start Later. In the Apply Schedule dialog box,
select an off-peak time to run the operation and click OK.
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4. Click Hide to return to the SSM screen.

Note that the status bar shows the schedule you just set up. You can click this status
bar message at any time to view or cancel the operation.
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Chapfer 2 Administering SnapServers

SnapServer Manager provides an easy way to manage single or multiple SnapServers
running GuardianOS through the Administer Servers configuration screen. It is accessed by
highlighting the systems to be configured and selecting Administration > Administer Servers
from the menu bar:

& BE=
File Edit Administration Help
# cervers & Administer 2 Servers =
o Ml =All G2 W Server Settings =
[T gerver Name
[T DateiTime
[T Admin Password
[ Ermail Motifcation Administering your selected servers.
[0 55H
E o s 1) Enable one or more operations in the list on the left. i
5 Windows/SMB ¥l Checktoenable. [ Uncheck to disable.
[Z Applearp . . A
= Np;?ge 2) Click View/Copy to view the curent operation settings
[ for all selected servers, or fo copy curent settings from a
Dere specific server. d i
[0 sMMP
Evmviil:\tenance E) Ediit the operation seftings and click Aoply to save these |
[ Shutdown settings to al selected servers. d L
[T Restart
[T 0% Update
d
d
Clear Selection
d
‘ ViewiCopy... ‘ | Apphy... ‘ ‘ Close | ‘ Help ‘ -
Mo operations are CarTery rommig Or SUIEanie, Ty oo el Offline: 113120

SnapServer Manager’

The screen title bar shows either the name of the system selected or, when performing
multisystem administration tasks, the number of systems selected (such as, Administer 2
Servers). When you check a feature to configure, a gray screen is displayed showing the
available settings along with some basic directions and information.

SnapServer Manager makes the following administrative tasks available for multisystem
administration.

e Server Settings — Server Name, Date/Time, Admin Password, Email Notification,
SSH, and UPS.

¢ Network Settings — Windows/SMB, Apple/AFP, NFS, NIS, FTP/FTPS, SNMP, and
Web.

* Maintenance Settings — Shutdown, Restart, and OS Update.

NOTE: For other tasks, such as storage configuration, use the Web Management Interface.
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Server Name

Check the Server Name option to name/rename the systems. If any of the selected systems

are currently members o

f a Windows domain, then you must rejoin the domain.

Administer 2 Servers

M Server Settings
[¥l Server Name

[0 DateiTime

[T Admin Passward
[Z1 Email Motification
[T ssH

[0 uPs

M Network Settings
[ windows/SMB
[T AppleisFP

[ NFS

[mRSE

M@ FTP

[0 anmP

(2 wieb

M Maintenance

[Z1 Shutdoven

[T Restart

[0 05 Update

Clear Selection

Server Hame

Server Name  |snAP_ |
Server Comment \ \ (optional)

Auto-increment names for multiple servers
Server Name Postfix Start 1 E
First generated server name: SNAP_1
Last generated server name: SNAP_2

If any of the selected servers are currently members of a Windows domain, then changing the serer name will require
rejoining the domain. Please enter the user name and password of 2 user in the domain with administrative privileges
(MNote: it a server youe selected is not a member of a domain, the following flelds will be ignored )

Administrator Name Administrator
Administrator Password

Important: This operation will restart the server, and is always performed lastin a sequence of operations.

| View/Copy... || Apply... H Close || Help ‘

When configuring a single system, the name you enter in the Server Name field is applied to
the server. When configuring multiple systems, the name you enter in the Server Name field
is used as the basis for the name of each of the systems in the group, and a number
differentiating each system is added by the auto-increment feature.

To change systems that are currently members of a Windows domain, changing the system
names will require rejoining the domain. Enter an administrator user name and password of

a user in this domain wit

h administrative privileges. If a system that has been selected is not

a member of a domain, the administrator name and password fields will be ignored.

Options

Description

Server Name The default system name is SNAPnnnnnn, where nnnnnn is the unique
server number (for example, SNAP242424).

System names are limited to 27 alphanumeric characters. You can also

use the dash (-), underscore (_) between characters, and spaces.

Server Comment  Optionally, add a comment (for example, system location) specific to
the system. This comment will be displayed in Windows Network

Neighborhood.
Server Name Select the starting number for the suffix of a series of system names
Postfix Start that use the same core name.
Administrator The user name and password of a user in the domain with
Name and administrative privileges.

Password

To Change a Single System Name

1. At Administration

> Administer Servers, click Server Name.

2. Enter the new name in the Server Name field (and a comment if desired).
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3. Enter an administrator’s name and password in the fields provided.
4. Do one of the following:
* To continue system configuration, select a different task.

e To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.

To Change Multiple System Names Using the Auto-increment Feature
Enter the base system name in the Server Name field.

2. By default, the auto-increment feature starts at one (1). Change this starting
number as appropriate.

3. Do one of the following:
¢ To continue system configuration, select a different task.

* To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.

Date/Time

Use this screen to configure date and time settings, to configure a SnapServer as an NTP
server, and to set the time zone used.

Administer 2 Servers

M Server Settings Date/Time
[0 Server Name
IR ETE ) Set this server's date & time to the follawing.
[0 Admin Password
[T Email Notification Use current {local computer’s) date and time
[T 25H Dat

O urs

B Network Settings
[0 windows/SME

51 AppleaFP (") Synchronize date & time to the following NTP server(s).
[ mFs i

[Z mis L i
[ FTP

[Z sHmP

2 wieh

M Maintenance
[Z Shutdown .
[0 Restart ["] Enable this server as an NTP server

[ 05 Update

Time Zone ‘(UT(L[IH:[I[I) Pacific Time (US & Canada) ‘ - |

Clear Selection

| ViewiCopy... H Apphy... H Close H Help |

The time stamp applies when recording system activity in the Event Log (Monitoring tab),
when creating or modifying files, and when scheduling snapshot, antivirus, or Snap EDR
operations.

Tip: The SnapServer automatically adjusts for Daylight Savings time.

Options Description

Date & Time Set either to the local computer (the computer on which SnapServer
Manager is installed) or enter manually.
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Options Description

NTP Servers Network Time Protocol (NTP) sets the date and time to a network server
rather than the local computer.

Enable NTP Put a check in this box to enable the SnapServer as an NTP server.

Server

Time Zone Defaults to UTC

CAUTION: If the current date and time are reset to an earlier date and time, the change does not
automatically propagate to any scheduled events you have already set up for snapshot, antivirus, or
Snap EDR operations. These operations will continue to run based on the previous date and time
settings. To synchronize these operations with the new date and time settings, reschedule each
operation.

Configure Date and Time Settings
1. At Administration > Administer Servers, click Date/Time.
2. Do one of the following:

e Use Computer Settings — Select Set this Server’'s Date & Time to the Following, then
check Use Current (Local Computer’s) Time and Date to use the current computer’s
settings, or clear the check box to manually set the time and date.

* Sync With NTP Server — Select Synchronize Date & Time to the Following NTP
Server(s) to sync systems to the NTP server, then add the system name or IP
address in the field provided. This option is only available for use with GuardianOS
4.0 and higher.

Select a Time Zone from the pull-down menu.

Do one of the following:
* To continue system configuration, select a different task.

e To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.
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Admin Password

This screen is used to manage the administrator-level password for a system. To prevent
unauthorized access to the system, create a secure password immediately.

Administer 2 Servers

M Server Settings Admin Password
[0 Server Name
[0 DateiTime Admin Password

[i7] Admin Password . y

[ Ernall Natiication| crtY Admin Password |
[0 25H

[0 urs

B Network Settings
[0 windows/SME
[0 ApplefAFF

[0 wFs

[0 mis

EFTP

[0 snuP

[0 wieb

M Maintenance

[0 Shutdown

[0 Restart

[T 08 Update

Clear Selection

Lo | e | e

Option Description

Admin Password The default password for the admin user account is admin. Use up to 15
(and Verify) alphanumeric characters. Passwords are case-sensitive.

To Create a New Admin Password
At Administration > Administer Servers, click Admin Password.

2. In the fields provided, enter the new password, and then repeat it in the field below
to verify the password.

3. Do one of the following:
* To continue system configuration, select a different task.

e To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.

Email Notification

NOTE: The Email Notification feature requires GuardianOS 6.0 or higher.
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To set up email alerts in response to system events, you will need the SMTP server’s IP
address or host name and the email address of at least one recipient (four are possible) who
is to receive an alert.

Administer 2 Servers
M Server Settings Email Notification

[0 Server Name

[0 DateiTime

[0 Admin Password

[l Email Notification
T 551 SMTP Server {Host name ar IP address)
[0 ups SMTP Port |25 (Port number for SMTP server

B Network Settings
[0 windows/SME

Enable Email Notification

Use Authenticated SMTP

[0 ApplefAFF o =

[0 wFs

[0 Mg Pa d

E ;‘I:IF;\AF' []Use Secure Connection

[ wieh

M Maintenance Email Address of Sender <Use default> ‘ s |

E ggigﬁwn Email Addresses of Recipients

[0 05 Update (optional)
{optional)
{optional)

Send email notification for the following events

|| Server shutdownirestart [ | RAID Set event | | Volume is full
[ Hardware event "I Printing event [ | Administrative operation event

[ ] License event

|| Send a test email after saving settings

Clear Selection

| ViewiCopy... H Apphy... H Close H Help |

Option

Description

Enable Email Notification

To enable email notification, check the Enable Email
Notification check box.

SMTP Server Enter a valid SMTP server IP address or host name.

SMTP Port Enter a port number for the SMTP server or accept the
default.

Use Authenticated SMTP Check this box to require authentication when an email is

sent to the SMTP server by a system. Provide an
authentication User Name and Password in the fields that
appear when the feature is enabled.

Use Secure Connection

Check this box to encrypt emails from a system. STARTTLS
and TLS/SSL encryption protocols are supported.

Email Address of Sender:

Choose:

* The default address (systemname@domain) where the
domain is the DNS domain name. If there is no DNS
domain name, then the system’s IP address for EthO will
be used (systemname@ipaddress)

 Specify a specific sender.

Email Addresses of
Recipients

Enter one to four email addresses to receive the
notifications. At least one address is required.
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Option Description

Send email notification for Check the boxes next to the events you wish to be notified
the following events about:

» Server shutdown/restart - The system shuts down or
reboots due to an automatic or manual process.

RAID Set event - For a RAID 1, 5,6, or 10, it experiences
a disk drive failure, a disk drive is removed, or it configures
a spare or a new disk drive as a member.

Volume is full - Storage space on a volume reaches 95%
utilization.

Hardware event - The internal temperature for the
system exceeds its maximum operating temperature or
other hardware problems.

Printing event - A printer error occurs (for example, the
printer is out of paper).

Administrative operation event - A Data Migration or
Unicode operation has finished or experienced an error.

License event - One of the trial licenses included on the
SnapServer is about to expire. A notification email will be
sent 14 days before the license expires. One day before
the license expires another email will be sent. It is
recommended that if you are not acquiring a license key
for the SnapExtension that is expiring, you turn off the
SnapExtension.

Send a test email after To verify your settings, check the box. After you apply the
saving settings settings, a test email will be sent to the recipients.

Configure Email Notification

10400352-002 12/2012

1.
2.
3.

At Administration > Administer Servers, click Email Notification.
Select the Enable Email Notification check box.

Enter the SMTP server IP address, and either enter a port number for the SMTP
server or accept the default.

If desired, select Use Authenticated SMTP and provide a user name and password to
require authentication when the system sends an email to the SMTP server.

If desired, select Use Secure Connection if you want the system emails to be encrypted.

Select an Email Address of Sender.

Designate an email address from which email notifications are to be sent. The default
is <Use default>, which uses either system Name@systemDomain (if a DNS Domain
Name is specified on TCP/IP screen), or system Name@systemIP (if a domain name is
not specified) as the default sender email address. To add a new email address, click
the Email Address of Sender field and type the desired email address. Alphanumeric
characters, except spaces, are accepted.

If desired, add up to three more recipient email addresses in the fields provided.
Select the system events of which you want to be notified.

Select Send a test email after saving settings to verify the configuration.

10. Do one of the following:

* To continue system configuration, select a different task.
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* To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.

SSH

Secure Shell (SSH) is a service that provides remote access to a command line shell that
allows the user to perform basic management and update functions outside the GuardianOS
Web Management Interface.

Administer 2 Servers
M Server Settings SSH
[0 Server Name
[0 DaterTime Enable SSH
[0 Admin Password
[0 Email Notification
[¥ 25H
[0 urs
B Network Settings
[0 windows/SME
[0 ApplefAFF
O nFs
[0 nig
EFTP
[0 snuP
[ wieh
M Maintenance
[0 Shutdown
[0 Restart
[0 05 Update

Clear Selection

| ViewiCopy... ‘ | Apphy... ‘ | Close ‘ | Help |

CAUTION: SSH is enabled by default. To maintain security, consider disabling SSH when not in use.

To Enable or Disable SSH
1. At Administration > Administer Servers, click SSH.
2. The Enable SSH check box toggles SSH on and off. Select to enable.
3. Do one of the following:

* To continue system configuration, select a different task.

* To apply changes made to all selected tasks, click Apply. Then, in the Apply to
Servers dialog, click Start to begin applying active settings.

UPS

APC®-brand Smart-UPS® series devices allow SnapServers to shut down gracefully in the
event of an unexpected power interruption.

For a network-based APC UPS device, you must configure UPS support on the SnapServer
as described in this section and identify the system to the APC software. In the APC UPS
Web-based user interface, navigate to the Power Chute configuration page, and add the
system’s IP address to the client list. If you are using DHCP, entering any IP address on your
network will work.
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UPS

IMPORTANT: For SnapServers with a single power supply, only the first procedure applies. The
second procedure applies to systems that have dual power supplies.

[0 Restart
[0 05 Update

Clear Selection

Administer 2 Servers
M Server Settings upPs
[Z] Server Name

D Datermime Enable UPS Support

[Z] Admin Password

[Z Email Natification

2] 55H ["] Automatically restart server when power is restored
[¥l UFs

W Network Settings (_) Use a single USB-connected UPS device

[0 windows/SME

[0 ApplesAFP (@ Use the ing network UPS devi

[T HFs Primary UPS Device

D 1P Address

O FTF -

[ SMMP APC User Name {for authentication)

[0 wieb APC Authentication Phrase

M Maintenance

[0 Shutdown [_| Secondary UPS Device (optional)

| ViewiCopy... H Apphy... H Close H Help |

Configure One (Primary) UPS Device

Complete the following fields and click Apply.

Option

Description

Enable UPS Support

Select option to enable or clear to disable UPS support.

Automatically restart server when
power is restored

Check this box to automatically restart the system when
power has been restored or the UPS comes back online.

Leave the check box blank to manually start the system after

a power failure.

Use a single USB-connected UPS
device

Select this radio button to use a USB-connected APC UPS
device.

Use the following network-
connected UPS device(s)

Select this radio button to use one or two network-connected
APC UPS devices.

IP Address

Enter the IP address of the system where the network UPS
resides.

APC User Name
(for authentication)

Enter the APC Administrator user name.

NOTE: The APC user name entered must be the APC
Administrator name for the UPS (by default, apc).

APC Authentication Phrase

Enter the authentication phrase configured for shutdown
behavior on the UPS (in the UPS Web UI, this can be
configured in PowerChute settings or, for older firmware, in
the User Manager for the administrator user).

NOTE: This password phrase is not the same as the user’s
password.

Configure a Secondary UPS Device

1. At Administration > Administer Servers, click UPS.
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2. Complete the following fields and click Apply.

Option Description

Secondary UPS Device (optional)  Select to enable (or clear to disable) a secondary UPS device.

IP Address Enter the IP address of the system where the network UPS
resides.

APC User Name Enter the APC Administrator user name.

(for authentication) NOTE: The APC user name entered must be the APC

Administrator name for the UPS (by default, apc).

APC Authentication Phrase Enter the authentication phrase configured for shutdown
behavior on the UPS (in the UPS Web UI, this can be
configured in PowerChute settings or, for older firmware, in
the User Manager for the administrator user).

NOTE: This password phrase is not the same as the user’s
password.

Shutdown server upon receiving a Select one of the following from the drop-down list:
low battery message from « Either UPS Device - Select this option to allow shutdown
upon receipt of a message from one of the two specified
UPS servers.
¢ Both UPS Devices - Select this option to allow shutdown
only upon receipt of one message from each of the two
specified UPS servers.

Windows/SMB

In addition to joining the system to a Windows workgroup or Active Directory domain,
several other options are available for Windows networking:

*  You can enable guest account access to the system for all Windows clients.
e With ADS domains, you can disable NetBIOS.

¢ For ADS domains, you must specify a valid user name and password to join the

domain.
Administer 2 Servers
M Server Settings Windows/SMB
[0 Server Name
3 DaterTime Enable Windows Networking (SMB)
[0 Admin Password
[0 Email Notification Member of =
[0 25H
0 ups Waorkgroup/Domain Name

M Network Settings
[l Windows/SME

[0 ApplefAFF

[0 wFs

O NS ["] Enable Guest Account

E ;‘I:IF;\AF' Enable Opportunistic Locking

[T ek [ Enable this server as the Master Browser
M Maintenance

[T Shutdown [_] Allow root authentication

[0 Restart

[0 08 Update [ Enable trusted domains

LDAP Signing

-Administrator name/password are required to join a domain

Clear Selection

ViewiCopy... H Apphy... H Close H Help |
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To Join a Workgroup

Edit settings as described in the following table, and then click Apply.

Option

Settings

Enable Windows (SMB)

Select to enable (or clear to disable) access to the system via the
SMB protocol.

Member Of

Select Workgroup from this pull-down menu.

Workgroup/Domain
Name

Enter the workgroup to which the system belongs.

Enable Guest Account

Select the Enable Guest Account option to allow unknown users
to access the system using the guest account. Clear the option to
disable this feature.

Enable Opportunistic
Locking

Enabled by default. Opportunistic locking can help performance if
the current user has exclusive access to a file.

Enable this server as
the Master Browser

A SnapServer can maintain the master list of all computers
belonging to a specific workgroup. (At least one master browser
must be active per workgroup.) Select to enable if you plan to
install this server in a Windows environment and you want this
server to be able to serve as the Master Browser for a workgroup.

Allow Root
Authentication

Select Allow Root Authentication to allow a root login on the
selected SnapServer.

To Join an Active Directory Domain

10400352-002 12/2012

At Administration > Administer Servers, click Windows/SMB.

2. Edit settings as described in the following table, and then click Apply.

Option

Settings

Enable Windows SMB

Select to enable (or clear to disable) access to the system via the
SMB protocol.

Member Of

Select Active Directory Domain from this pull-down menu.

Workgroup/Domain
Name

The default settings make the system available in the workgroup
named “Workgroup.” Enter the domain name to which the system
belongs.

Organizational System

You must enter the name of the organizational system within the
Active Directory tree in which the system will appear. By default,
the system appears within the container named Computers.

To join a sub-level of an organizational system, enter the path in
the following format: /[organizational system]/[sub-
system1]/[sub-system1a].

Disable NetBIOS over
TCP/IP

Check the box to disable NetBIOS or clear it to leave NetBIOS
enabled.

Enable Guest Account

Select the Enable Guest Account option to allow unknown users
to access the system using the guest account. Clear the option to
disable this feature.

Enable Opportunistic
Locking

Enabled by default. Opportunistic locking can help performance if
the current user has exclusive access to a file.
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Option Settings

Enable this sever asthe A SnapServer can maintain the master list of all computers

Master Browser belonging to a specific workgroup. (At least one master browser
must be active per workgroup.) Select to enable if you plan to
install this server in a Windows environment and you want this
server to be able to serve as the Master Browser for a workgroup.

Allow Root Select Allow Root Authentication to allow a root login on the

Authentication selected SnapServer.

Enable Trusted SnapServers recognize trust relationships established between

Domains the domain to which the SnapServer is joined and other domains
in a Windows environment by default. Check the box to allow this
feature.

Administrator Enter a user name and password with sufficient administrative

Name/Password privileges to allow a remote computer to join the domain.

Apple/AFP

Macintosh clients connecting over AFP can authenticate to the system as a local user or
guest. If the system is joined to an Active Directory domain, AFP clients can also optionally
authenticate against the domain (enabled by default). The default settings provide access to
Macintosh clients over an AppleTalk or TCP/IP network.

Administer 2 Servers
M Server Settings Apple/AFP

[Z Server Name

[ DateTime Enable Apple Filing Protocol (AFP)

[Z Admin Passward

[Z] Email Notification Add Server Name to Apple Shared Folder Names

[Z 58H

[0 urs Authenticate AFP users against Windows domains

M Network Settings
[2 Windows/SME
[¥] AppleisFP

[0 MRS

[Z mis

[ FTP

[ SMmP

[2 el

M Maintenance
[Z Shutdown

[X Restart

[ 05 Update

Clear Selection

ViewiCopy... H Apphy... H Close H Help |

Edit Apple/AFP Settings
1. At Administration > Administer Servers, click Apple/AFP.
2. Edit settings as described in the following table, and then click Apply.

Options Usage

Enable Apple Filing Select to enable (or clear to disable) AFP access.
Protocol (AFP)
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NFS

Options

Usage

Add Server Name to
Apple Shared Folder
Names

Select to show both the server name and share name in the
Connect to Server dialog box. Clear the check box to display only

the share name.

Authenticate AFP users

against Windows
domains

a Windows domain, if configured.

NOTE: By default, users are authenticated against the domain
first, then against the local database, so if the same user
name exists on both the domain and the SnapServer, the
domain user will take precedence. To force an AFP client
to log in as either user, prefix the user name with either
the Windows domain name or the SnapServer’s
servername. For example: windowsdomain\username or

snapl1234567\username.

Select this option to automatically authenticate AFP users against

NFS

GuardianOS supports NFS v2/3/4, each version being individually configurable. Optionally,
Kerberos-based security is supported for NFS v4.

Administer 2 Servers

M Server Settings
[Z] Server Name

[Z DateiTime

[Z] Admin Password
[Z] Email Notification
[ 55H

[0 ups

M Network Settings
[2 Windows/SME
[ AppleisFP

[¥l MFS

[Z mis

[EFTP

= sHmP

[2 wiel

M Maintenance

[Z Shutdown

[X Restart

[ 05 Update

Clear Selection

NFS

Enable NFS
Enable NFSv2
Enable NFSv3
| Enable NFSv4
Domain Hame
() Standard NFS Security
() RPC!

S Security (Unix Kerberos)

Realm Name
Keytah File
@) Use existing keytab file

iMote: this MFS operation will not proceed if a keytab file does not exist on the server)

| Browse... |

) Use new keytab file

{Note: a new keytab file can only be applied 10 2 single serer)

Client code page | 7r :

ViewiCopy... H Apphy... H Close H Help |

Edit NFS Settings

1. At Administration > Administer Servers, click NFS.

1. NFSis enabled by default. To disable NFS, uncheck the Enable NFS box.

2. Select the versions of NFS that you want to enable (NFS v2, NFS v3, and NFS v4).
The Enable NFS box must also be checked in order to enable any of the NFS versions.

3. If you enable NFS v4, complete information for the following fields:

Option

Description

Standard NFS Security

Click this button if you want to use standard NFS security.
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Option Description

RPSEC GSS Security Click this button and then complete the following fields if you

(Unix Kerberos) want to use Unix Kerberos security to authenticate NFS v4
connections:

¢ KDC Host Name - Enter the host name or IP address of the
Kerberos server.

* Realm Name - Enter the Kerberos realm name.

¢ Keytab File - Select Use existing keytab file; or, select Use
new keytab file and Browse to locate and upload a keytab
file generated for the SnapServer.

4. Use the Client Code Page drop-down menu to select a page type.
The Keep current value option allows you to change the NFS enable-state without
changing the code page. This is the default setting for servers that have not had
Unicode enabled. You can change the Client Code Page for a server only if Unicode has
been enabled. Unicode is always enabled in GuardianOS 6.5 and higher. Use the Web
Management Interface to enable Unicode for servers using GuardianOS 6.0 or earlier.

5. Click Apply.

NIS

A GuardianOS SnapServer can join an NIS domain and function as an NIS client. It can
then read the users and groups maintained by the NIS domain. Thus, you must use the NIS
server to make modifications.

Administer 2 Servers

M Server Settings NIS
[0 Server Name

[0 DaterTime [ | Enabie NIS
[T Admin Password P

[0 Email Notification
[0 25H

[0 urs

B Network Settings
[0 windows/SME
[T Apple/AFP

[Z MFs

[l 1S

[EFTP

[Z sHmP

2 wieh

M Maintenance

[Z Shutdown

[Z Restart

[ 05 Update

Clear Selection

ViewiCopy... H Apphy... H Close H Help |

To Join an NIS Domain

1. At Administration > Administer Servers, click NIS.
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2. Edit settings as described in this section, and then click Apply.

Option Description
Enable NIS Select to enable (or clear to disable) NIS Authentication.
NIS Domain Enter the NIS domain name.

Broadcast and bind to any  Select this option to bind to all available NIS servers.

NIS server
Broadcast and bind to the  Select this option and then enter up to four valid NIS server IP
following NIS servers addresses.

NIS Facts

Consider the following facts when configuring NIS access:
You cannot modify NIS user or group accounts locally

You must use the NIS server to make modifications. Changes you make on the NIS server do
not immediately appear on the SnapServer; it may take up to 10 minutes for changes to be
replicated.

Possible conflicts between NIS and SnapServer UIDs/GIDs

e NIS identifies users by UID, not user name, and although it is possible to have
duplicate user names, Overland Storage does not recommend this configuration.
e If you join the SnapServer to an NIS domain, consider the following guidelines:

* The SnapServer does not recognize users or groups who have identification
numbers less than 100.

e Each UID or GID must be unique.
¢ You should not define a UID or GID that has been previously assigned, and you
cannot define a UID or GID that is currently assigned.
Specify Client Access

As a security measure, list only users who need access, rather than allowing all NFS clients
access to SnapServer shares.

FTP/FTPS

FTP/FTPS clients can access the system using local users or the anonymous account. The
anonymous user is mapped to the system's local guest user account. Administrators can set
share access for anonymous FTP/FTPS users by granting either read-write (the default
access) or read-only access to the guest account on a share-by-share basis. For more granular
control over FTP/FTPS access, administrators must create local user accounts for FTP/FTPS
users.
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Administer 2 Servers

M Server Settings FTP
[0 Server Name
[0 DaterTime Enable FTP
[0 Admin Password
[T Email Notification Enable FTPS
[0 25H
[0 urs [_| Enable Anomymous User Access

B Network Settings
[0 windows/SME
[0 ApplefAFF

[0 mFs

[0 mis

[¥ FTP

[0 snuP

[0 wieb

M Maintenance
[0 Shutdown

[0 Restart

[ 05 Update

Clear Selection

ViewiCopy... H Apphy... H Close H Help |

Edit FTP/FTPS Settings
1. At Administration > Administer Servers, click FTP.

2. Edit settings as described below, and then click Apply.

Option Settings

Enable FTP Select to enable (or clear to disable) access to this system via the
FTP protocol.

Enable FTPS Select to enable (or clear to disable) access to this system via the
secure FTPS protocol.

Enable Anonymous When you allow anonymous user access, FTP/FTPS users employ

User Access an email address as the password. When you disallow anonymous
access, only FTP/FTPS users who are configured as local system
users can access the system.

* Select this option to allow users to connect to the system using
the anonymous user account. The anonymous user is mapped to
the system's local guest user account. Administrators can set
share access for anonymous FTP/FTPS users by granting either
read-write (the default access) or read-only access to the guest
account on a share-by-share basis.

¢ Clear this option to prevent anonymous user access. FTP/FTPS
users can may still log in via a locally created user name and
password.

SNMP

The Simple Network Management Protocol (SNMP) views a network as a collection of
cooperating, communicating devices that consists of managers and agents. The system can
act as an SNMP agent. Once SNMP is enabled on a system, SNMP managers can access
management data on the system from MIB-II and the Host Resources MIB.
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Administer 2 Servers
M Server Settings SNMP

[0 Server Name

O DateiTime Enable SHMP

[0 Admin Password = )

[0 Email Notification Bubichs public |

D 33K Private Community private (optionaly

O urs :

M Network Settings Eaiagincing (optionaly

[0 Windows/SME Contact Person ’7 (optionaly

[0 ApplesAFP
[0 NFS

[0 Mg

D FTP

[i7] SNMP

[0 wiel

M Maintenance
[T Shutdown
[T Restart

[T 08 Update

[ Enahle SNMP Traps

Clear Selection

| ViewiCopy... H Apphy... H Close H Help |

Supported Network Manager Applications

You can use any network manager application that adheres to the SNMP V2 protocol with a
system. The following products have been successfully tested: CA Unicenter TNg, HP Open
View, and Tivoli NetView.

Default Traps

A trap is a signal from the system informing an SNMP manager program that an event has
occurred. The following default traps are supported:

¢ coldStart — An SNMP agent has restarted.
¢ linkDown — An Ethernet interface has gone off-line.
¢ linkUp — An Ethernet interface has come online.

* authenticationFailure — An attempt to query the SNMP agent using an incorrect
public or private community string was made, and resulted in a failure.

¢ enterpriseSpecific — System-generated traps that correspond to the error-level,
warning-level, and fatal-error-level traps of the OS. These traps contain a descriptive
message that helps to diagnose a problem.

Configure SNMP
1. At Administration > Administer Servers, click SNMP.
2. Edit settings as described below, and then click Apply.

Option Description
Enable SNMP Select to enable (or clear to disable) SNMP.
Public Community To enable SNMP managers to read data from this system,

enter the name of one or more public communities, or
accept the default snap_public.
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Web

Option

Description

Private Community

To enable SNMP managers to remotely configure this
system, enter the name of one or more private
communities, or accept the default snap_private. Create
unique public and private names. As a precaution against
unauthorized access, Overland Storage recommends that
you create your own public and private community hames.

Server Location

Enter information that helps a user identify the physical
location of the system. For example, you might include a
street address for a small business, a room location such
as Floor 37, Room 308, or a position in a rack, such as rack
slot 12.

Contact Person

Enter information that helps a user report problems with
the system. For example, you might include the name and
title of the system administrator, a telephone number,
pager number, or email address.

Enable SNMP Traps

Select to enable (or clear to disable) SNMP traps.

|IP Address 1-4

Enter the IP address of at least one SNMP manager in the
first field as a trap destination. You can enter up to three
additional IP addresses.

Send a Test Trap

Select this option to verify your settings when you apply
them.

Web

The Web configuration screen is used to manage authentication and non-secure access to the

Web Management Interface.

Administer 2 Servers

M Server Settings
[0 Server Name

[0 DateiTime

[0 Admin Password
[0 Email Notification
[0 25H

[0 urs

B Network Settings
[0 windows/SME
[0 ApplefAFF

[0 mFs

[0 mis

D FTP

[0 snuP

[l wieh

M Maintenance

[0 Shutdown

[0 Restart

[ 05 Update

Clear Selection

[] Require Weh Authentication

Enable {(non-Secure) HTTP Access

Important: Existing Web Root settings (which can only be edited via the ¥yeb on Toal) will be rr
when you click Apply.

Mote: This operation is always performed last in a sequence of operations.

| ViewiCopy... H Apphy... H Close H Help |

The Web Management Interface opens when users access a SnapServer using their web
browsers. It displays a list of all shares to which the user has access. Users can navigate the
share structure to locate and view or download files, but they cannot modify or upload files.
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HTTP and HTTPS are the default protocols used for browser-based access to the system.
HTTPS enhances security by encrypting communications between client and system, and
cannot be disabled. You can, however, disable HTTP access. Additionally, you can require
browser-based clients to authenticate to the system.

Enable Web Authentication
1. At Administration > Administer Servers, click Web.

2. Edit the following setting, and then click OK.

Option
Require Web Select this option to require HTTPS or HTTP clients to enter a valid
Authentication user name and password in order to access the system. Clear this

option to allow access to the system without authentication.

Enable Non-Secure HTTP Access
Edit the following setting, and then click OK.

Option
Enable (non-secure) Select this option to enable HTTP client access to the system.
HTTP access Clear to disable. (HTTPS is always enabled.)

NOTE: To access the CA eTrust Antivirus configuration interface
(on the Web Management Interface’s Snap Extensions
screen), HTTP must be enabled.

Shutdown

This task shuts down and powers off the systems being administered. There are no options
to select or complete. At Administration > Administer Servers, select the Shutdown task to
activate it, and then click Yes to confirm. It is always performed last if more than one
operation is selected.

Administer 2 Servers

M Server Settings Shutdown
[Z] Server Name
[ DateiTime Shutdown is always performed lastin a sequence of operations.
[Z] Admin Password
[Z Email Natification
[Z 58H

[0 urs

M Network Settings
[Z windows/SMB
[T ApplesAFP

[ mFs

[Z mis

[ FTP

[Z sHmP

2 wieh

M Maintenance

[ Shutdown

[Z Restart

[ 05 Update

Clear Selection

| Apphy... H Close H Help |
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NOTE: If updating the firmware, after clicking Apply, select either Start Now or Start Later. See
Chapter 3, “Apply to Servers.”

Restart
This task restarts the systems being administered. There are no options to select or
complete. At Administration > Administer Servers, select the Restart task to activate it, and
then click Yes to confirm. It is always performed last if more than one operation is selected.
M Server Settings Restart
Server Mame
DatelTime
Admin Password
Email Notification
S5H
UPS
M Network Settings
Windows/SME
Apple/AFP
MFS
MIS
FTP
SHMP
Wigh
M Maintenance
Shutdown
. OEi Upnale
Clear Selection
| ViewiCopy... ‘ | Apphy... ‘ | Close J | Help I
NOTE: If updating the OS software, after clicking Apply, select either Start Now or Start Later. See
Chapter 3, “Apply to Servers.”
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OS Update

This task updates the OS (the software that governs the system’s functionality). It is
mutually-exclusive from all other Administration functions.

Administer 2 Servers

M Server Settings 0S Update
[0 Server Name
[0 DateiTime You can download the latest OS software from:
[0 Admin Password www.snapser rver.

[0 Email Mot d

E 3?: 05 File || Browse..

B Network Settings
[0 windows/SME

[0 ApplefAFF Important: This operation rmay restartthe server
O nFs
[0 nig
O FTF

[0 snuP

[0 wieb

M Maintenance
[0 Shutdown
[0 Restart

[¥]l 05 Update

Clear Selection

| viewicopy.. \| Apply... H Close H Help |

CAUTION: Do not interrupt this process. You may severely damage the system if you interrupt a
software update operation.

Update the GuardianOS Software
1. At Administration > Administer Servers, click OS Update.
Download the update by clicking the download link on the OS Update screen.
Follow the instructions provided to download the update file.
Click Browse, locate the file you’ve downloaded, and select it.

Click Apply.

Ll O

The Apply to Server screen opens, listing systems and their update status. Select when
to start the update:

(5] Apply to Servers

Press Startto begin applying settings to the fallowing servers.

Server | AppleAFEP
Snap1 234867 | Mot started
SnapTe54321 | Mot started

Fit columns in display

| Start Now H Start Later... |‘ Stop ‘ | Report... H Close H Help |

* Click Start Now to confirm the OS update. The system updates the OS and then
reboots.
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* Click Start Later to schedule the update to run at a later time.

NOTE: If you schedule the update for a later time, you will not be able to perform any other
operations on the systems being updated until the scheduled update is done.

* Click Report to receive a report when the scheduled update is finished.
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Chapter 3 SSM Dialog Box Reference

This section describes some of the SnapServer Manager dialog boxes and their usage
associated with the Edit and Administration menu options:

File Ed“| Administration Help File Edit n_dministration| Help
L New Group...
% B Rename Group...

Administer Servers...
Launch Web Administration...

¢ 0 Remove Offline Servers Set |P Address...
Copy Wake Up Servers...
Paste Feature Licensing...
Delete Register Servers...
Select All Check for Server Software Updates...
Properties...
Remote Servers...
Options...
Refresh All F5

Edit Menu Dialog Boxes:

While New Group, Rename Group, and Remove Offline Servers have simple dialog boxes,
the following menu items have additional options in their dialog boxes:

¢ Server Properties
* Remote Servers
*  Options
Administration Menu Dialog Boxes:
These special menu and sub-menu options apply to GuardianOS servers only:
¢ Administering Servers
e Apply Schedule (Start Later)
* Apply to Servers
* Operations Report
* Current Settings for Servers
o Set IP Address!
e Feature Licensing

o Server Software Updates!

Server Properties

The Server Properties dialog box (Edit > Properties or right-click system name) provides a
summary of system specifications and status data.

1. Also applies to RAINcloudOS nodes and clusters.
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Server Properties - CCSunDragon (Online)
Properties
Property Value
Server Name CCSunCragon -
Server Mumber 2411056
hodel D2
05 Version (Guardian0S ¥.1.008
EBIOS Version 1.08 T
Service Pack Mone
Serial Numnber PL1P2411056
Dizcovery IP Address 182.168.193.247 (validated, Changed: 0} 1
Metwork Interface Count 2
Ethernet 1 (Primary Interface)
IP Address 19216844112 (DHCP)
Subnet Mask 255,245 265.0
Default Gateway 182168.192.1
DNE Server 192168.192.22
Domain Name dewnet. myoverland.net
Ethernet (MAC) Address 00:CO:BE24:CA30 =l
Status Total Storage Usage
Server CCSunDragon is online.
& Drive: oK <1% Used
EEEthemet: 0K L 1
Pawer Supphz 0K
Fan: oK Total: 559 GB
] System Temp: Ok Used: 4.4 MB (<1%)
3] CPU Temp: ]34 Free: 5.83 GB (~99%)
‘ Refresh || Close || Help |

Ethernet Indicators (GuardianOS only)

The following table explains the status coding for the Ethernet status indicators.

Status Description
E All Ethernet connections are operating properly.
E At least one Ethernet connection has a link error. Possible

causes include a loose or faulty cable; or perhaps a problem
(Only displayed if the no-link with a connecting switch or hub.

status check box is enabled NOTE: SSM cannot distinguish between a NIC that is not in

in the Options dialog box) use and a NIC that is disconnected. If you are using
only one NIC on a system, the NIC status will remain
yellow.

E At least one Ethernet interface is not functioning.

E Ethernet status is not available (system may be offline).

The Discovery IP Address

The word Discovery is placed next to the IP address used to discover the system. SSM uses
this IP address to communicate with the system when performing View/Copy and Apply
operations.

Total Storage Usage (GuardianOS/RAINcloudOS only)

For GuardianOS SnapServers the percentage refers only to capacity that has been allocated
to existing volumes; unallocated RAID capacity is not included. For RAINcloudOS Clusters
the percentage refers to the storage usage of the entire cluster.
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Remote Servers

Select Edit > Remote Servers to open this dialog box. It is used to add systems that reside
outside the network segment on which SnapServer Manager resides. See Chapter 1, “System
Discovery.”

Remote Servers

New Remote Server | |

Add

Remote Servers: 2

192.168.193.128 (Snap7654321)
192.168.193.141 (Snap1234567)

2

Remote server refresh interval (seconds) | &0

Enable discovery of remote servers

Available Options

These options are available with this dialog box:

Add Remote Systems

Enter the system’s IP address or server/cluster name in the New Remote Server field and
click Add.

e Ifyou entered the IP address, it appears in the Remote Servers list box, with the
system name in parentheses (if resolved).

¢ Ifyou entered the server/cluster name, it appears in the Remote Servers list box, with
the IP address in parentheses (if resolved).

e If SSM cannot find the remote system you entered, unresolved appears in the Remote
Servers list box.

The current number of remote servers/clusters is listed above the Remote Servers list box.
The maximum allowed remote servers/clusters is 5000.

NOTE: If the remote systems being imported would make the full list greater than 5000 systems,
SSM displays a prompt to truncate the list being imported.

Delete a Remote System

In the Remote Servers list box, select one or more remote systems and click Delete.

Adjust the Remote System Refresh Interval

Adjust the interval to a setting between 30 seconds and 90 seconds.

Toggle Discovery of Remote Systems

Click the Enable discovery of remote servers check box.

10400352-002 12/2012 ©2010-12 Overland Storage, Inc. 43-3



SnapServer Manager 7.2-3.0 Users Guide Options

Importing a Remote Server List

Options

Remote server/cluster names and/or IP addresses can be imported from a text file. Within
the text file, each system and IP address can be designated either by entering one system per
line, or by entering multiple names separated by a space, a comma, or a semi-colon. Blank
lines and lines beginning with the number sign (#) are ignored.

Import a Remote Servers List
Click the Import button and navigate to the appropriate text file. Click OK.

The remote servers list will be added to the existing list, ignoring duplicate systems.

The Options dialog box allows you to:
¢ Specify the Web browser that SSM uses.

¢ Set the period after which a system will be considered offline after receipt of the last
discovery packet.

e Specify whether SSM displays a warning if any Ethernet port has no link
(GuardianOS/RAINcloudOS only).

¢ Instruct SSM to directly scan all systems.
¢ Configure an HTTP proxy server for online registration (GuardianOS only).

¢ Enable or disable automatic notification of OS updates (GuardianOS/RAINcloudOS
only).

Options

Weh Browser ‘<Use default Web browsers| |v H Browse... H Test... |

Server offline timeout (seconds) | 130]
Display a warning if any of a server’s Ethernet ports have no link
[] Auto-scan servers not on Remote Server list

[_] Use a proxy server for HTTP communication

Enable automatic update notification

Specify a Web Browser

You can specify the Web browser you would like SnapServer Manager to use to display the
Web Management Interface and the SSM help system.

¢ Click Browse to navigate to and select the executable for your chosen browser.

¢ Click Test to open this help window in your chosen browser.

Adjust the System Offline Timeout Setting

SSM constantly updates the system list with fresh data it receives from systems that reside
on its local network segment and are specified on the Remote Servers list. SSM considers a
system offline if no communication occurs for the specified time-out period. (The default
timeout period is 180 seconds.) If SSM receives no communication from a system for 180
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seconds, it displays that system as offline in the Details List of the main SSM screen. Adjust
this interval to a setting between 120 seconds and 300 seconds as appropriate for your
network conditions.

Display No-Link Status Warnings for Ethernet Ports (GuardianOS/RAINcloudOS)

SSM is set by default to display a warning status if one of a system’s Ethernet ports has no
link. With this feature activated, you can quickly see all systems with no-link status
Ethernet ports (such as, unplugged Ethernet cables). You may wish to disable the no-link
status feature if you have systems with only one connected Ethernet port. To disable the
feature, uncheck the Display warning if any of a server’s Ethernet ports has no link check box, and
click OK.

Activate Auto-scanning of All Remote Systems

When SnapServer Manager is installed on a laptop that is moved from one network segment
to another, some remote systems may appear to be offline when they are in fact online. The
Auto-scan servers not on Remote Servers list option ensures that discovery works properly by
sending discovery request packets to each system discovered in a previous session; this
solution does, however, increase network traffic. To activate auto-scanning, select the check
box and click OK.

Use an HTTP Proxy Server (GuardianOS/RAINcloudOS)

In environments that use an HTTP proxy server to access the Internet, SSM must be
configured to use the proxy for online server registration, update notification, or accessing
the web online help. Check Use a proxy server for HTTP communication, enter the name or IP
address of the proxy server in the Proxy host field, and enter the port used by the proxy server
in the Proxy port field.

Enable Automatic Update Notification (GuardianOS/RAINcloudOS)

SSM is configured by default to check daily for available updates to GuardianOS and
RAINcloudOS. When an update is found for discovered servers/clusters, an alert displays in
a banner at the top of the SSM main window. The Tell me more link in the banner opens the
Software Updates dialog, listing systems for which an update is available, the version of OS
each system is currently running, and the version of the update available.

Tip: You can choose to hide the banner by clicking the "Remind me later” or "Hide this
message” link on the banner. When “Remind me later” is clicked, the system displays the
banner after the next check for updates; when “Hide this message” is clicked, the system
hides the banner for the specific update until a later version is released.

To disable this feature, uncheck the Enable Automatic Update Notification check box and click
OK.
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Administering Servers

Select Administration > Administer Servers to open this dialog box. It is the starting point for
configuring, viewing, or copying settings for servers running GuardianOS.

Administer 2 Servers

M Server Settings
[0 Server Name

[0 DateiTime

[0 Admin Password
[0 Email Notification
[0 25H

[0 urs

Administering your selected servers.

Enable one or more operations in the list on the left.

M Hetwork Settings 1 N

[ Windows/SME -l vl Check to enable. [ Uncheck o disable.

[0 ApplesAFP . _ _

0 MFS o | Click View/Copy o view the cument operation seftings
DS = for al selected servers, or to copy curent setfings from a
L specific server,

[0 SMMP

E VM\';il:\tenance é) Ediit the operation setfings and click Apply to save these
[ Shutdown seftings to all selected servers.

[T Restart

[T 0% Update

Configure Settings

1. Select a task in the left pane.
A check mark indicates the task is active and its fields are editable.

Edit the settings as appropriate.
Repeat Steps 1-2 for any other tasks to be modified.
When you are finished configuring settings, click Apply.

o~ Db

In the Apply to Servers dialog, click Start Now (or Start Later) to begin applying
modifications across systems.

NOTE: If you schedule the update for a later time, you will not be able to perform any other
operations on the systems being updated until the scheduled update has completed.

View or Copy Settings

1. Select the tasks whose settings you want to view or copy.
A check mark indicates the task is active.

Click View/Copy.

In the Current Server Settings dialog, click Start to begin retrieving settings.

3 Current Settings for Servers

Press Start to begin retrieving settings from the following servers

Legend: [ Settings not retrieved. @ Settings identical for all servers. 0 Settings differ between senvers

10400352-002 12/2012

Sener

O ‘WindowsISMB

O Apple/aFP

OnFs

Snap1234567

ot stared

Mot started.

Mot started.

Snap7654321

Mot stared

Mot started.

Mot started.

Fit columns in display  [_] Compact rows

‘ Start “ Stop | ‘ Copy H Report... H Close H Help |
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4. When copied, close this window to return to the Administer Servers window.

The selected settings will be populated with the copied values.

Apply Schedule (Start Later)

When administering GuardianOS server options (see “Administering Servers” on page 3-6),
clicking Apply opens the Apply to Server dialog box with a Start Later button located at the
bottom. You can use it to schedule a set of operations to run up to one week in the future.

Apply Schedule &
pply

Specify a day and time to start the operations.

Day ‘Tuday - Tue. November 15, 2011 | - ‘

Time |11:59 AM E

Before scheduling operations, note the following:

* SnapServer Manager must remain running — For scheduled operations to take
effect at the specified time, SSM must remain running. SSM will display an error
message if you attempt to close the application while operations are scheduled.

* No other operations are possible — Until a scheduled operation completes, no other
changes can occur. SSM allows you to run one set of operations at a time; you cannot
start one set of operations on one group of servers, and then run a different set on
another group of servers while the first operation is still scheduled or running.

Schedule Operations to Run at a Later Time
1. Select a day and time from the fields provided, and click OK.
The Hide button appears in the Apply to Servers dialog box.
2. Click Hide to return to the main SSM screen.

You can monitor GuardianOS server status and properties, manage server groups, and
administer servers using the Web Management Interface, but no other operations can
be run until after the scheduled operations are completed.

Change a Scheduled Operation

If a scheduled operation exists, the Status Bar on the screen displays a message similar to
the following:

Operations are scheduled to run on Monday January 11, 2010 at
1:57 PM. (Click to view.)

Click the message to view or cancel the scheduled operations. After the Apply to Servers
screen reopens, you can do one of the following:

* Click Stop to cancel the scheduled operations.

¢ (Click Hide to return to the main SSM screen.
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Apply to Servers

When administering GuardianOS server options (see “Administering Servers” on page 3-6),
clicking Apply opens this dialog box. It lists operations to be performed on a group of servers
running GuardianOS.

’} Apply to Servers

Press Start to begin applying settings to the following servers

Sener \ ApplesAFP
iSnap1 234567 \ Mot started
Snap7B54321 \ Mot started

Fit columns in display

Start Now H Start Later... Stop Report... H Close H Help |

Available Options
The three buttons at the bottom activate the options available with this dialog box:

Run the Operations Now

Click Start Now. The interface informs you of the progress (progress bar) and result of the
operations.

Schedule the Operations to Run Later
1. Click Start Later.

2. In the Apply Schedule dialog box that opens, select a date and time and click OK.
You return to the Apply to Servers dialog box.

3. Click Hide to return to the main screen.

Tip: The status barin the main screen displays the status of the scheduled operations. While
operations are scheduled to run, no other multiserver administration is possible.

Generate an Operations Report
1. Click Report to open the Operations Report dialog box.
2. Do one of the following:

* To set up email report delivery for this and all future operations, complete the
fields provided and click OK.

e To save an operations report for this operation only, click Save Report.

Improve the Readability of the Display

When working with a large number of settings or servers, use the following methods to
improve the readability of the display.
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Method Description

Fit Columns in Display When selected (default), this option resizes column widths to
fitin the current size of the window. All columns are visible, but
text within columns may be clipped.

When deselected, column widths expand to fit the width of its
contents, but some columns may not be visible.

Resizing columns To resize a column, hover the cursor over the border between
column headers, and then click and drag to the desired width

Operations Report

When administering GuardianOS server options (see “Administering Servers” on page 3-6),
clicking Apply opens the Apply to Servers dialog box with a Reports button located at the
bottom. Clicking that button opens this dialog box which serves two functions:

¢ Configuring SSM to automatically deliver an operations report by email.

¢ Saving an individual operations report as a CSV file.

Operations Report

Specify settings to automatically send a report via email.

[] Send email report when operations finish

| OK || Save Report... H Cancel H Help ‘

View a Sample Operations Report
Below is an operations report on changing SSH settings for three servers:

SnapServer Manager Report:

All operations completed successfully on Monday January 11, 2011 at
8:29 AM.

Operations started by user Jjsmith on machine sales/209.219.19.19, on
Monday January 11, 2011 at 8:29 AM.

Server SSH

Server_1 OK

Server_2 OK

Server_3 OK

Configure SSM to Automatically Deliver Operations Reports By Email
Complete the following fields and click OK.

Option Description

Send Email Report Select this option to have SSM email all operations reports to the
specified recipients.

SMTP Server Enter the mail server IP address.
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Option Description

Email Addresses Enter up to two email addresses in the spaces provided.

Send Test Email Click this button to verify your settings.

Save a Single Copy of an Operations Report

Click Save Report to open a Save dialog box and save the report as a CSV file to a location of
your choice.

Current Settings for Servers

When administering GuardianOS server options (see “Administering Servers” on page 3-6),
clicking View/Copy opens this dialog box. It allows administrators to view and compare
settings across a group of servers running GuardianOS. A legend for the headings is
displayed at the top.

’} Current Settings for Servers

Press Startto begin retrieving settings from the fallowing servers.

Legend: O Settings not retrieved. @ Settings identical for all servers. O Settings differ hetween senvers.

Server

O Windows/SMB

O Apple/aFP

ONFS

Snap1 234567

Mot stared

Mot started

Mot started

SnaprA54321

Mot started

Mot started

Mot started

Fit columns in display [ | Compact rows

Start Stop Copy Report... ‘ Close Help

Available Options

The three buttons at the bottom activate the options available with this dialog box:

View and Compare Settings Across a Group of Servers

Click Start. The interface provides feedback on the progress of the operation in the form of a
progress bar. The legend indicates where settings differ among servers.

Copy Settings
Select a server row, and then click Copy. Close this window to return to the Administer
Servers window. The selected settings will be populated with the copied values.

Generate an Operations Report

Once SSM retrieves server settings, the Report button becomes available. Click Report to
save the settings to a CSV file.
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Improve the Readability of the Display

When working with a large number of settings or servers, use the following methods to
improve the readability of the main display.

Method Description

Fit Columns in Display When selected (default), this option resizes column widths to
fit in the current size of the window. All columns are visible, but
text within columns may be clipped.

When deselected, column widths expand to fit the width of its
contents, but some columns may not be visible.

Compact Rows When selected, this option displays only the first text line of
each row. All (or most) server rows will be visible, but most text
is clipped.

When deselected (default), all text lines display, but it may be
necessary to use the scroll bars to see some rows and/or
columns.

Resizing columns To resize a column, hover the cursor over the border between
column headers, and then click and drag to the desired width

Set IP Address

By default, SnapServers and Uninitialized nodes are preconfigured to use DHCP to acquire
an IP address at startup. If a Uninitialized node cannot find a DHCP server on the network,
it will default to a “ZeroConf” IP address (169.254.*.*) and you may not be able to see the
server on your network. In this case, the Set IP Address feature can be used to assign a fixed
IP address to the server.

NOTE: GuardianOS 6.0 and earlier servers will show 10.10.10.10 as the IP address in this case
rather than a ZeroConf address.

Set IP Address is only available for SnapServers and Uninitialized nodes that are configured
for DHCP and have not received an IP address from a DHCP server.

Set a Server’s or Cluster’s IP Address
1. In the SSM main screen, select a server/cluster.
2. Right-click the server/cluster, and select Set IP Address.

3. Enter the following required information in the TCP/IP Addressing fields:
e [P address

e Subnet mask

4. Optionally, you may also specify the default gateway, domain name server, domain
name, and WINS server as appropriate.
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Feature Licensing

Use the Feature Licensing menu (Administration > Feature Licensing) to apply SnapExtension
license keys to one or more GuardianOS servers. There is no limit to the number of licenses
that can be entered using this dialog box. Click Enter License, then enter one or more license
keys per line or separated by spaces, and click OK. This feature is only available with
GuardianOS v 4.0 or later.

¥ Feature Licensing
Click the Enter License button below to enter one ar more license keys for licensing features
an your server(s). Features can include Registration licensing and SnapExtensions licensing.
Registration andfor SnapExiension license keys can be purchased online at
Wiy Snapserer.comistare.
Servers to license

Server Name \ Server Mumber \ Licenses Applied
Snap1234567 |sn07398
Snap7B54321 [1225733 T

The Feature License dialog box does not display any pre-existing SnapExtension licenses.
Only licenses that have been applied while the current dialog box is open will be displayed.

Server Software Updates

When you select Administration > Check for Server Software Updates, the SnapServer Manager
connects with a remote server to determine if any of the GuardianOS servers or
RAINcloudOS nodes it is monitoring have new software updates available.

SnapServer Manager

Communicating with remote software update server. This
E== may take a few minutes. Please wait...

The resulting dialog box lists all of the systems that SSM has discovered that have updates
available, and provides the following information about the systems:

Property Description

Server Name Name of the system that has an update available.

Current OS version Version of the OS currently running on the system.

Update OS version Most recent version of the OS to which the system can be updated.

Apply Software Updates
1. To download the available OS update, click the Download this software link.

2. Apply the software update:

For GuardianOS, SSM creates a special SSM Server Group called <Updates Available>.
It contains all the systems for which each update is applicable. Apply the software
update to the systems in this folder.
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